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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

 DANGER 
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

 WARNING 
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

 CAUTION 
indicates that minor personal injury can result if proper precautions are not taken. 

 

 NOTICE 
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

 WARNING 
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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 Preface 1 
 

 

Trademarks 
The following and possibly other names not identified by the registered trademark sign ® are 
registered trademarks of Siemens AG: 

C-PLUG, CP 343-1, CP 443-1, SCALANCE, SIMATIC, SOFTNET 

Validity of the documentation 
This manual will familiarize you with the handling and all important properties of the following 
SCALANCE S devices:  

● SCALANCE S602, article number: 6GK5602-0BA10-2AA3 

● SCALANCE S612, article number: 6GK5612-0BA10-2AA3 

● SCALANCE S623, article number: 6GK5623-0BA10-2AA3 

● SCALANCE S627-2M, article number: 6GK5627-2BA10-2AA3 

You will learn how the device can be installed and commissioned in a few simple steps. 
 

 Note 

The specified approvals apply only when the corresponding mark is printed on the product.  
 

Notes on configuration  
The SCALANCE S devices listed above can be configured with the following tools: 

 
Configuration tool Relevant documentation 
Security Configuration Tool (standalone and 
integrated in STEP 7 as of V5.5 SP2 HF1) 

Configuration manual "SIMATIC NET Industrial Ethernet Security - Ba-
sics and Application". You will find a current release on the Internet un-
der the following entry ID: 56577508 
(http://support.automation.siemens.com/WW/view/en/56577508) 

STEP 7 as of V12 Online help "Information system", section "Industrial Ethernet Security" 

The descriptions of configuring SCALANCE S devices in this manual refer to the Security 
Configuration Tool. 

Information on media modules and SFPs 
The media modules and SFPs that can be used for the SCALANCE S627-2M are listed in 
the next section of this manual: 
Technical specifications (Page 11) 

http://support.automation.siemens.com/WW/view/en/56577508
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You will find more detailed information on the use media modules and SFPs such as 
technical specifications, instructions for installation and commissioning on the Internet under 
the following entry ID: 74843168 
(http://support.automation.siemens.com/WW/view/en/74843168) 

SIMATIC NET glossary 
Explanations of many of the specialist terms used in this documentation can be found in the 
SIMATIC NET glossary. 

You will find the SIMATIC NET glossary here: 

● SIMATIC NET Manual Collection or product DVD 

The DVD ships with certain SIMATIC NET products. 

● On the Internet under the following address: 

50305045 (http://support.automation.siemens.com/WW/view/en/50305045) 

Security information 
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, solutions, machines, equipment and/or networks. They are 
important components in a holistic industrial security concept. With this in mind, Siemens’ 
products and solutions undergo continuous development. Siemens recommends strongly 
that you regularly check for product updates. 

For the secure operation of Siemens products and solutions, it is necessary to take suitable 
preventive action (e.g. cell protection concept) and integrate each component into a holistic, 
state-of-the-art industrial security concept. Third-party products that may be in use should 
also be considered. For more information about industrial security, visit 
http://www.siemens.com/industrialsecurity. 

To stay informed about product updates as they occur, sign up for a product-specific 
newsletter. For more information, visit http://support.automation.siemens.com. 

http://support.automation.siemens.com/WW/view/en/74843168
http://support.automation.siemens.com/WW/view/en/50305045
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 Safety notices 2 
 

 

Read the safety notices 
Note the following safety notices. These relate to the entire working life of the device. 

You should also read the safety notices relating to handling in the individual sections, 
particularly in the sections "Installation" and "Commissioning". 

2.1 General notices 
Do not start up until you have established that the machine on which you intend to run this 
component complies with the directive 89/392/EEC. 

 

 NOTICE 

Battery change 

Each SCALANCE S device has a battery. This battery must not be changed by customers 
or by service personnel. A battery can only be changed in the MF-K production factory. If 
this becomes necessary, send the device to the following address with the remark "battery 
change": 

 

Siemens AG 

I IA SC MF-K BP51 

Repair Center 

Östliche Rheinbrückenstr. 50 

76187 Karlsruhe, Germany 
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2.2 Information on use in hazardous areas 
 

 WARNING 

When used in hazardous environments corresponding to Class I, Division 2 or Class I, 
Zone 2, the device must be installed in a cabinet or a suitable enclosure. 

 

 

 WARNING 

EXPLOSION HAZARD 

DO NOT CONNECT OR DISCONNECT EQUIPMENT WHEN A FLAMMABLE OR 
COMBUSTIBLE ATMOSPHERE IS PRESENT. 

 

 

 WARNING 

EXPLOSION HAZARD 

SUBSTITUTION OF COMPONENTS MAY IMPAIR SUITABILITY FOR CLASS I, DIVISION 
2 OR ZONE 2. 

 

 

 WARNING 

EXPLOSION HAZARD 

DO NOT OPEN WHEN ENERGIZED. 
 

 

 WARNING 

The device may only be operated in an environment with pollution degree 1 or 2 (see IEC 
60664-1). 

 

 

 WARNING 

The equipment is designed for operation with Safety Extra-Low Voltage (SELV) by a 
Limited Power Source (LPS). 

This means that only SELV / LPS complying with IEC 60950-1 / EN 60950-1 / VDE 0805-1 
must be connected to the power supply terminals. The power supply unit for the equipment 
power supply must comply with NEC Class 2, as described by the National Electrical Code 
(r) (ANSI / NFPA 70). 

If the equipment is connected to a redundant power supply (two separate power supplies), 
both must meet these requirements. 
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 WARNING 

If a device is operated in an ambient temperature of more than 45 ℃, the temperature of 
the device housing may be higher than 70 °C. The device must therefore be installed so 
that it is only accessible to service personnel or users that are aware of the reason for 
restricted access and the required safety measures at an ambient temperature higher than 
45 ℃. 

 

2.3 Notices on use in hazardous areas according to ATEX and IECEx 

Safety notices for use according to ATEX and IECEx 

If you use the device under ATEX or IECEx conditions you must also keep to the following 
safety notices in addition to the general safety notices for protection against explosion: 

 

 WARNING 

To comply with EC Directive 94/9 (ATEX95) or the conditions of IECEx, this enclosure or 
cabinet must meet the requirements of at least IP54 in compliance with EN 60529. 

 

 

 WARNING 

Take measures to prevent transient voltage surges of more than 40% of the rated voltage. 
This is the case if you only operate devices with SELV (safety extra-low voltage). 

 

 

 WARNING 

Safety measures at higher temperatures 

If the cable or conduit entry point exceeds 70 °C or the branching point of conductors 
exceeds 80 °C, special precautions must be taken. If the equipment is operated in an air 
ambient in excess of 50 °C up to 70 ℃, only use cables with an admitted maximum 
operating temperature of at least 100 ℃. 

 

 

 WARNING 

EXPLOSION HAZARD 

Do not press the RESET button if there is a potentially explosive atmosphere. 
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2.4 Information on use in hazardous areas according to UL-Hazloc 

Safety notices when using the device according to Underwriters Laboratories for Hazardous 
Locations (UL-HazLoc) 

If you use the device under UL-HazLoc conditions you must also keep to the following safety 
notices in addition to the general safety notices for protection against explosion: 

 

 WARNING 

EXPLOSION HAZARD 

DO NOT DISCONNECT WHILE CIRCUIT IS LIVE UNLESS AREA IS KNOWN TO BE 
NON-HAZARDOUS. 

 

This equipment is suitable for use in Class I, Division 2, Groups A, B, C and D or non-
hazardous locations only. 

This equipment is suitable for use in Class I, Zone 2, Group IIC or non-hazardous locations 
only. 

2.5 Information on use in hazardous areas according to UL 

Valid only in areas where NEC or CEC applies 
 

 WARNING 

Warning for areas subject to NEC or CEC: 

Safety notice for connectors with LAN (Local Area Network) marking: 

A LAN or LAN segment, with all its associated interconnected equipment, shall be entirely 
contained within a single low-voltage power distribution and within a single building. The 
LAN is considered to be in an "environment A" according IEEE802.3 or "environment 0" 
according IEC TR 62102, respectively. 

Never make direct electrical connection to TNV-circuits (Telephone Network) or WAN 
(Wide Area Network). 
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 Description 3 
3.1 Technical specifications 

 
Connections  
Attachment of end devices or network components over twisted 
pair  

10/100/1000 Mbps (half/full duplex) 

SCALANCE S602/S612 2 x RJ-45 jacks with MDI-X assignment  
SCALANCE S623 3 x RJ-45 jacks with MDI-X assignment 
SCALANCE S627-2M 3 x RJ-45 jacks with MDI-X assignment 

2 x media modules slots each for one 2-port media 
module 

Connector for power supply 1x4-pin plug-in terminal block 
Connector for signaling contact 1x2-pin plug-in terminal block 
Electrical data   
Power supply Supply 24 VDC (19.2 to 28.8 VDC) 

• Implemented redundantly 
• Safety extra-low voltage (SELV) 

Typical power consumption at 24 VDC, 1000 Mbps 
SCALANCE S602/S612 9.0 W 
SCALANCE S623 9.7 W 
SCALANCE S627-2M 12.0 W without media modules / max. 2.5 W extra per 

media module 
Max. current consumption at rated voltage 
SCALANCE S602/S612 0.5 A 
SCALANCE S623 0.5 A 
SCALANCE S627-2M 0.7 A 
Permitted cable lengths  
Connection over Industrial Ethernet FC TP cables 
0 - 100 m Industrial Ethernet FC TP standard cable with 

IE FC RJ-45 plug 180 
or  
Over Industrial Ethernet FC outlet RJ-45 with 0 - 90 m 
Industrial Ethernet FC TP standard cable + 10 m 
TP cord  

0 - 85 m Industrial Ethernet FC TP marine/trailing cable with 
IE FC RJ-45 plug 180 
or 
0 - 75 m Industri-
al Ethernet FC TP marine/trailing cable + 10 m 
TP cord 
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Permitted environmental conditions for SCALANCE S602 / S612 / S623  
Operating temperature (vertical installation) 
Horizontal DIN rail (normal position) 
All other positions (e.g. vertical DIN rail) 

 
-40 ℃ to +60 ℃ 
- -40 ℃ to +40 ℃ 

Storage/transport temperature -40 °C through +80 °C 
Max. relative humidity in operation 95% (no condensation) 
Max. ambient temperature at operating altitude Up to 2000 m above sea level at max. 56 °C ambient 

temperature 
Up to 3000 m above sea level at max. 50 °C ambient 
temperature 

Permitted environmental conditions for SCALANCE S627-2M  
Media module: Operating tempera-

ture (vertical installa-
tion): 

Stor-
age/tra
nspor-
tation 
tem-
pera-
ture: 

Max. relative humidi-
ty in operation at 25 
°C: 

Max. ambient tem-
perature at operating 
altitude: 

Without or with the following media mod-
ules: 
• MM991-2 (BFOC) 
• MM991-2LD (BFOC) 
• MM991-2 (SC) 
• MM991-2LH+ 
• MM991-2LD (SC) 
• MM992-2 
• MM992-2LD 
• MM992-2LH 
• MM992-2LH+ 
• MM992-2ELH 
• MM992-2CUC 
• MM992-2CU 
• MM992-2M12 
• MM992-2VD 

Horizontal mounting 
rail (normal position): 
-40 ℃ to +60 °C 
All other positions 
(e.g. vertical mount-
ing rail): -40 °C to 
+50 °C 

-40 °C 
to +80 
°C 

95% (no condensa-
tion) 

Horizontal standard 
rail (normal position): 
• up to 2000 m 

above sea level 
at max. 56 °C 

• up to 3000 m 
above sea level 
at max. 50 °C 

All other positions 
(e.g. vertical stand-
ard rail): 
• up to 2000 m 

above sea level 
at max. 40 °C 

• up to 3000 m 
above sea level 
at max. 35 °C 



 Description 
 3.1 Technical specifications 

SCALANCE S 
Commissioning and Hardware Installation Manual, 04/2017, C79000-G8976-C266-07 13 

With media module MM992-2SFP and the 
following SFP transceivers:  
• SFP991-1 
• SFP991-1LH+ 
• SFP991-1LD 
• SFP992-1 
• SFP992-1LD 
• SFP992-1LH 
• SFP992-1LH+ 
• SFP992-1ELH 
• SFP991-1ELH200 

Horizontal mounting 
rail (normal position): 
-40 ℃ to +50 °C 
All other positions 
(e.g. vertical mount-
ing rail): -40 °C to 
+40 °C 

-40 °C 
to +80 
°C 

95% (no condensa-
tion) 

Horizontal standard 
rail (normal position): 
• up to 2000 m 

above sea level 
at max. 45 °C 

• up to 3000 m 
above sea level 
at max. 40 °C 

All other positions 
(e.g. vertical stand-
ard rail): 
• up to 2000 m 

above sea level 
at max. 40 °C 

• up to 3000 m 
above sea level 
at max. 35 °C 

Approvals  
ATEX Zone 2 EN 60079-15 
Construction 
Installation options • 35 mm DIN rail 

• S7-300 standard rail 
• Wall mounting 

Dimensions (W x H x D) in mm 
SCALANCE S602/S612/S623 60 x 125 x 124 
SCALANCE S627-2M 120 x 125 x 124 
Weight in g 
SCALANCE S602/S612 790 
SCALANCE S623 815 
SCALANCE S627-2M 1300 
Article numbers   
SCALANCE S602 6GK5602-0BA10-2AA3 
SCALANCE S612 6GK5612-0BA10-2AA3 
SCALANCE S623 6GK5623-0BA10-2AA3 
SCALANCE S627-2M 6GK5627-2BA10-2AA3 
System manual "SIMATIC NET Industrial Ethernet Network Man-
ual" 

6GK1970-1BA10-0AA0 

Article numbers for supported media modules (for SCALANCE S627-2M) 
MM991-2 (BFOC) 6GK5991-2AB00-8AA0 
MM991-2LD (BFOC) 6GK5991-2AC00-8AA0 
MM991-2 (SC) 6GK5991-2AD00-8AA0 
MM991-2LH+ 6GK5991-2AE00-8AA0 
MM991-2LD (SC) 6GK5991-2AF00-8AA0 
MM992-2 6GK5992-2AL00-8AA0 
MM992-2LD 6GK5992-2AM00-8AA0 
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MM992-2LH 6GK5992-2AN00-8AA0 
MM992-2LH+ 6GK5992-2AP00-8AA0 
MM992-2ELH 6GK5992-2AQ00-8AA0 
MM992-2CUC 6GK5992-2GA00-8AA0 
MM992-2CU 6GK5992-2SA00-8AA0 
MM992-2M12 6GK5992-2HA00-0AA0 
MM992-2VD 6GK5992-2VA00-8AA0 
Article number for supported SFP media module (for SCALANCE S627-2M) 
MM992-2SFP 6GK5992-2AS00-8AA0 
Article numbers for supported SFPs (for SFP media module) 
SFP991-1 6GK5991-1AD00-8AA0 
SFP991-1LH+ 6GK5991-1AE00-8AA0 
SFP991-1LD 6GK5991-1AF00-8AA0 
SFP991-1ELH200 6GK5991-1AE30-8AA0 
SFP992-1 6GK5992-1AL00-8AA0 
SFP992-1LD 6GK5992-1AM00-8AA0 
SFP992-1LH 6GK5992-1AN00-8AA0 
SFP992-1LH+ 6GK5992-1AP00-8AA0 
SFP992-1ELH 6GK5992-1AQ00-8AA0 
Article numbers for accessories 
IE FC Stripping Tool 6GK1901-1GA00 
IE FC blade cassettes 6GK1901-1GB00 
IE FC TP standard cable (Fast Ethernet) 6XV1840-2AH10 
IE FC TP trailing cable (Fast Ethernet) 6XV1840-3AH10 
IE FC TP marine cable (Fast Ethernet) 6XV1840-4AH10 
IE FC TP standard cable 4X2(gigabit Ethernet) 6XV1870-2E 
IE FC TP flexible cable 4X2 (gigabit Ethernet) 6XV1870-2H 
IE FC RJ-45 Plug 180 (Fast Ethernet) 
pack of 1 

6GK1901-1BB10-2AA0 

IE FC RJ-45 Plug 180 (Fast Ethernet) 
pack of 10 

6GK1901-1BB10-2AB0 

IE FC RJ-45 Plug 180 (Fast Ethernet) 
pack of 50 

6GK1901-1BB10-2AE0 

IE FC RJ-45 Plug 180 4X2 (gigabit Ethernet) 
pack of 1 

6GK1901-1BB11-2AA0 

IE FC RJ-45 Plug 180 4X2 (gigabit Ethernet) 
pack of 10 

6GK1901-1BB11-2AB0 

IE FC RJ-45 Plug 180 4X2 (gigabit Ethernet) 
pack of 50 

6GK1901-1BB11-2AE0 

IE FC M12 Plug PRO 4x2 (gigabit Ethernet) 
pack of 1 

6GK1901-0DB30-6AA0 

IE FC M12 Plug PRO 4x2 (gigabit Ethernet) pack of 8 6GK1901-0DB30-6AA8 
FC FO termination kit 6GK1900-1GL00-0AA0 
FC FO standard cable GP 6XV1847-2A 
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FC FO trailing cable 6XV1847-2C 
FC SC Plug, pack of 10 6GK1900-1LB00-0AC0 
FC BFOC Plug, pack of 20 6GK1900-1GB00-0AC0 
FC SC Coupler, pack of 5 6GK1900-1LP00-0AB0 
FC BFOC Coupler, pack of 10 6GK1900-1GP00-0AB0 
C-PLUG 6GK1900-0AB00 

3.2 Hardware characteristics 
All SCALANCE S devices have the following essential characteristics: 

Hardware  
● Rugged housing with degree of protection IP20 

● Optional mounting on an S7-300 or DIN 35 mm rail, wall mounting 

● Redundant power supply  

● Signaling contact 

 
Figure 3-1 SCALANCE S627-2M 
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3.3 Components of the product 

What ships with the SCALANCE S?  
● SCALANCE S device 

● 2-pin plug-in terminal block (signaling contact)  

● 4-pin plug-in terminal block (power supply) 

● Information on the product 

● DVD with the following content:  

– Manual 

– Security Configuration Tool configuration software 

The SOFTNET Security Client is provided on a separate DVD and does not ship with the 
product. 

3.4 Power supply 
 

 WARNING 

Use safety extra-low voltage only 

The SCALANCE S device is designed for operation with safety extra-low voltage. This 
means that only safety extra-low voltages (SELV) complying with IEC950/EN60950/ 
VDE0805 can be connected to the power supply terminals.  

The power supply unit to supply the SCALANCE S must comply with NEC Class 2 (voltage 
range 19.2 - 28.8 V). 

The device may only be supplied by a power unit that meets the requirements of class 2 for 
power supply units of the "National Electrical Code, Table 11 (b)". If the device is connected 
to a redundant power supply (two separate power supplies), both must meet these 
requirements.  

 

 Note 

Never connect the SCALANCE S to AC voltage or to DC voltage higher than 28.8 VDC.  
 

The power supply is connected using a 4-pin plug-in terminal block. The power supply can 
be connected redundantly. Both inputs are isolated. There is no distribution of load. When a 
redundant power supply is used, the power supply unit with the higher output voltage 
supplies the SCALANCE S alone. The power supply is connected over a high resistance 
with the enclosure to allow an ungrounded set up.  
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Figure 3-2 Power supply for SCALANCE S627-2M 

3.5 Signaling contact 
 

 Note 

The signaling contact can be subjected to a maximum load of 100 mA (safety extra low 
voltage (SELV), 24 VDC).  

Never connect the signaling contact of the SCALANCE S to AC voltage or to DC voltage 
higher than 32 VDC. The polarity of the connectors is irrelevant. 

 

The signaling contact is connected to a 2-pin plug-in terminal block. The signaling contact is 
a floating switch with which error/fault states can be signaled by breaking the contact.  

The following errors/faults can be signaled by the signaling contact: 

● Fault in the power supply 

● Internal fault 

When only one power supply of a redundant power supply is applied, an error is signaled. 

If a fault occurs or if no power is applied to the SCALANCE S, the signaling contact is 
opened. In normal operation, the signaling contact is closed. 
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Figure 3-3 Signaling contact for SCALANCE S627-2M 
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3.6 Displays 

 
Figure 3-4 Operating displays 

 

① Port status display P1 

② Port status display P2 

③ Port status display P3 

④ Port status display P4 

⑤ Port status display P5 

⑥ Port status display P6 

⑦ Port status display P7 

⑧ Fault display (F) and power display (L1, L2) 
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Fault indicator (fault LED)  
Display of the operating state: 
 
Status Meaning 
Lit red Device detects an error 

(Signaling contact is open) 
The following faults/errors are detected: 
• internal fault/error (e.g. startup failed) 
• Invalid C-PLUG (invalid formatting) 

Lit green Device is in productive operation 
(Signaling contact closed) 

Not lit Device failure; no power supply 
(Signaling contact is open) 

Lit orange (constant) Device is starting up 
(Signaling contact is open) 
If no IP address was assigned, the device remains in this status. 

Flashes orange and red alter-
nately 

Device resets itself to factory settings 
(Signaling contact is open) 

Power LEDs (L1, L2)  
The status of the power supply is indicated by two LEDs: 
 
Status Meaning 
LED L1 / L2 
Lit green Power supply L1 or L2 is connected. 
Not lit in non-redundant mode: Power supply L1 or L2 is not connected or 

< 14 V (L+). 
Lit red In redundant mode: One of the two connected power supplies L1 

or L2 failed during operation or < 14 V (L+).  

Port status indicator (green/yellow LEDs)  
The status of each of the interfaces is indicated by a two-color LED per port: 
 
Device 
type 

Number of port LEDs LED lit green LED lit yellow 

S602 2 TP link exists, no data recep-
tion. 

TP link exists, data traffic at 
TP port. S612 2 

S623 3 
S627-2M 7 
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 Note 
Learn phase of the SCALANCE S602 in ghost mode 

While the SCALANCE S602 is learning the IP address of the internal node in ghost mode, 
the two port LEDs of the SCALANCE S602 ≥ V3.1 flash synchronized according to the 
following pattern, assuming there is no further data traffic: "Long - Long - Short". 
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 Deployment planning 4 
4.1 Unpacking and checking 

Unpacking, checking 
1. Make sure that the package is complete. 

2. Check all the parts for transport damage. 

 

 
 WARNING 

Do not use any parts that show evidence of damage. 
 

4.2 Attachment to Ethernet 

Possible attachments  
Each SCALANCE S device has a certain number of ports to which the network nodes can be 
connected. Depending on the interface, the network nodes are handled differently. 

 
SCALANCE S device Interface Ports of the interface Port type 
SCALANCE S602 / S612 External P1 Built-in RJ-45 jack (copper) 

Internal P2 Built-in RJ-45 jack (copper) 
SCALANCE S623 External P1 Built-in RJ-45 jack (copper) 

Internal P2 Built-in RJ-45 jack (copper) 
DMZ P3 Built-in RJ-45 jack (copper) 

SCALANCE S627-2M External P1 Built-in RJ-45 jack (copper) 
P4 Media module port (copper/FOC) 
P5 Media module port (copper/FOC) 

Internal P2 Built-in RJ-45 jack (copper) 
P6 Media module port (copper/FOC) 
P7 Media module port (copper/FOC) 

DMZ P3 Built-in RJ-45 jack (copper) 
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The Ethernet interfaces must not be confused when connecting to the communications 
network: 

● X1 interface - external 

Red marking = unprotected network area; 

● Interface X2 - internal 

Green marking = network protected by SCALANCE S; 

● Interface X3 - DMZ (universal network interface) 

Green marking = unprotected network area or network protected by SCALANCE S. 

If the interfaces are swapped over, the device loses its protective function. 
 

 Note 

TP cords or TP-XP cords with a maximum length of 10 m can be connected at the RJ-45 TP 
ports. 

In conjunction with the Industrial Ethernet FastConnect IE FC Standard Cable and IE FC RJ-
45 Plug 180, a total cable length of maximum 100 m is possible between two devices. 

 

 Note 
4x2 TP cable required for gigabit connection 

For data transfer at 1000 Mbps, you need to connect gigabit devices with 4 x 2 TP cables 
(twisted pair) to the SCALANCE S ≥ V4. 

 

You will find more detailed information on cabling via Industrial Ethernet on the Internet 
under the following entry ID: 27069465 
(http://support.automation.siemens.com/WW/view/en/27069465) 

Autonegotiation  
The SCALANCE S device supports autonegotiation. 

Autonegotiation means that the connection and transmission parameters are negotiated 
automatically with the network component connected to the interface of the SCALANCE S.  

MDI / MDIX autocrossover function  
The SCALANCE S device supports the MDI / MDIX autocrossover function. 

The advantage of the MDI /MDIX autocrossover function is that straight-through cables can 
be used throughout and crossover Ethernet cables are unnecessary. This prevents 
malfunctions resulting from swapping over send and receive cables. This greatly simplifies 
installation. 

The MDI / MDIX autocrossing function can only be used if autonegotiation is enabled. 

http://support.automation.siemens.com/WW/view/en/27069465
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Insulation between the TP ports  
Between the TP ports, an insulation voltage of 1.5 kV is adhered to (corresponds to 
IEEE802.3, Section 33.4.1.1, Environment B). 

See also 
Technical specifications (Page 11) 

4.3 Reset button - resetting the configuration to the factory settings 
SCALANCE S switches have a reset button. The reset button is located on the rear of the 
housing below the M32 plug immediately above the C-PLUG.  

 
Figure 4-1 Reset button and slot for the C-PLUG 

 

 Note 

Make sure that only authorized personnel has access to the SCALANCE S device. 
 

What does the reset button do? 
Two functions can be triggered with the reset button: 

● Restart 

The device is restarted. The loaded configuration is retained. 

● Reset to factory settings 

The device is restarted and reset to the status set in the factory. A configuration loaded 
on the SCALANCE S device or on an inserted C-PLUG is deleted. 
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Restart - follow the steps below 
1. If necessary, remove the SCALANCE S device from its mounting to allow access to the 

compartment. The compartment is protected by a screw plug. 

2. Remove the M32 plug on the rear of the device. 

The reset button is in a compartment on the rear of the SCALANCE S directly above the 
slot for the C-PLUG. 

3. Press the reset button for less than five seconds. 

The restart takes up to 2 minutes. During the restart, the fault LED is lit orange. Make 
sure that the power supply is not interrupted during the reset.  

On completion of the restart, the device automatically changes to productive mode. The 
fault LED is then lit permanently green. 

4. Close the recess with the M32 plug and mount the device again. 

Reset to factory settings - follow the steps below  
 

 Note 

If a C-PLUG is plugged in when you reset to factory settings, the C-PLUG is erased. 
 

1. If necessary, remove the SCALANCE S device from its mounting to allow access to the 
compartment. The compartment is protected by a screw plug. 

2. Remove the M32 plug on the rear of the device. 

The reset button is in a compartment on the rear of the SCALANCE S directly above the 
slot for the C-PLUG. 

3. Keep the reset button pressed for a minimum of 5 seconds until the fault display flashes 
orange-red. 

Resetting takes up to 2 minutes. During the reset, the fault LED flashes orange-red. Make 
sure that the power supply is not interrupted during this time.  

On completion of the reset, the device starts up again automatically. The restart takes up 
to 2 minutes. During the restart, the fault LED is lit orange. Make sure that the power 
supply is not interrupted during the reset.  

4. Close the recess with the M32 plug and mount the device again. 
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4.4 C-PLUG (configuration plug) 

Area of application  
The C-PLUG is an exchangeable medium for storage of the configuration and project 
engineering data of the basic device (SCALANCE S). This means that the configuration data 
remains available if the basic device is replaced. 

How it works 
Power is supplied by the basic device. The C-PLUG retains all data permanently when the 
power is turned off. 

Removing the C-PLUG  
It is only necessary to remove the C-PLUG if the basic device fails (hardware fault). 

 

 NOTICE 

Check the operating status 

The C-PLUG may only be removed when the power is off. 
 

Replacing the C-PLUG  
 

 NOTICE 

Damage to hardware by replacing during operation 

Replacing the C-PLUG during operation can lead to damage to the hardware (device and 
C-PLUG).  

Replace the C-PLUG only when the device is turned off. 
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Inserting and removing the C-PLUG  
The slot for the C-PLUG is located on the back of the device. You insert the  
C-PLUG as follows: 

1. Remove the M32 plug.  

2. Insert the C-PLUG in the intended slot. 

3. Then close the slot with the M32 plug. 

 
Figure 4-2 Inserting the C-PLUG in the device and removing the C-PLUG from the device with a 

screwdriver 

Function 
If an empty C-PLUG (factory settings) is inserted, all configuration data of the SCALANCE S 
is shifted to it when the device starts up. Changes to the configuration during operation are 
also saved on the C-PLUG without any operator intervention being necessary.  

A basic device with an inserted C-PLUG automatically uses the configuration data of the C-
PLUG when it starts up. This is, however, only possible when the data was written by a 
compatible device type. 

This allows fast and simple replacement of the basic device. If a device is replaced, the C-
PLUG is taken from the failed component and inserted in the replacement. After it has 
started up, the replacement device has the same device configuration as the failed device.  

 

 Note 
Consistent project data - adapting the MAC address  

After replacing the device with a spare, the configuration data should be consistent. To 
achieve this, you should adapt the MAC address from the project engineering to the MAC 
address printed on the replacement device. 

If you use the previously configured C_PLUG of the device you are replacing, this is not 
absolutely necessary to start up and run the device.  
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 Note 
Reset to factory settings 

If a C-PLUG is plugged in when you reset to factory settings, the C-PLUG is erased.  
 

 Note 
Setting the time-of-day after inserting a C-PLUG 

After you have inserted the C-PLUG in a new device, check the time-of-day on the device to 
make sure the certificates are still valid. 

 

Use of a C-PLUG that already contains configuration data 
Use only C-PLUGs that are formatted for the relevant SCALANCE S device type. C-PLUGs 
that have already been used in other device types and formatted for these device types must 
not be used. 

The following table shows which C-PLUG you can use for which SCALANCE S device type: 
 

SCALANCE S device type C-PLUG formatted by 
S602 V2 S612 V2 

/ 
S613 V2 

S602 
V3 

S602 ≥ 
V3.1 in 
ghost 
mode 

S602 V4 S612 
V3 

S612 
V4 

S623 
V3 

S623 
V4 

S627-
2M V4 

S602 V2 x - - - - - - - - - 
S612 V2 / 
S613 V2 

- x - - - - - - - - 

S602 V3 x - x - - - - - - - 
S602 ≥ V3.1 in ghost mode - - - x - - - - - - 

S602 V4 x - x x x - - - - - 
S612 V3 - x - - - x - - - - 
S612 V4 - x - - - x x - - - 
S623 V3 - - - - - - - x - - 
S623 V4 - - - - - - - x x - 

S627-2M V4 - - - - - - - - - x 
 

 
x C-PLUG can be used with the device type 
- C-PLUG cannot be used with the device type 

Before you use a formatted C-PLUG for another device, you will need to reset the 
SCALANCE S device to the factory settings by pressing the reset button and then download 
the required project to the SCALANCE S device. The use of C-PLUGs that are formatted 
without a module ID is possible without resetting to the factory settings. 
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Procedure after removing or after damage to a C-PLUG 
After inserting a C-PLUG, the configuration data of the SCALANCE S device is copied to the 
C-PLUG and deleted from the internal non-volatile memory of the SCALANCE S device. 
After removing a C-PLUG or if a C-PLUG is damaged, there is therefore no configuration 
data available. To return the SCALANCE S to operation either download the required 
configuration to the SCALANCE S or insert a C-PLUG with the required configuration in the 
SCALANCE S. 

Diagnostics 
Inserting a C-PLUG that does not contain the configuration of a compatible device type, 
removing the C-PLUG during operation, or general malfunctions of the C-PLUG are 
indicated by the diagnostics mechanisms of the end device (fault display red). 
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 Mounting 5 
5.1 Notes on installation 
 

 Note 
Keeping to the relevant installation guidelines 

During installation and operation, keep to the installation instructions and safety-related 
notices as described here and in the system manual "Industrial Communication SIMATIC 
NET Industrial Ethernet Network Manual" (entry ID: 27069465 
(http://support.automation.siemens.com/WW/view/en/27069465)). 

 

 

 CAUTION 

Provide suitable shade to protect the device against direct sunlight. This avoids unwanted 
warming of the device and prevents premature aging of the device and cabling. 

 

 

 Note 

The requirements of EN61000-4-5, surge test on power supply lines are met only when a 
Blitzductor BVT AVD 24V type no. 918 422 is used.  

Manufacturer: 
DEHN+SÖHNE GmbH+Co. KG Hans Dehn Str.1 Postfach 1640 D-92306 Neumarkt, 
Germany 

 

5.2 Types of installation 

Types of installation  
The SCALANCE S can be installed in various ways: 

● Installation on a 35 mm DIN rail  

● Installation on a SIMATIC S7-300 standard rail  

● Wall mounting  

http://support.automation.siemens.com/WW/view/en/27069465
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5.2.1 Installation on a DIN rail 

Installation  
Install the SCALANCE S on a 35 mm DIN rail complying with DIN EN 50022. 

1. Place the upper catch of the device over the top of the DIN rail and then push in the lower 
part of the device against the rail until it clips into place. 

2. Install the electrical connecting cables and the terminal block for the signaling contact. 

 
Figure 5-1 SCALANCE S installation on a DIN rail (35 mm) 
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Uninstalling  
To remove the SCALANCE S from the DIN rail: 

1. First disconnect the TP cables and pull out the terminal block for the power supply and 
the signaling contact. 

2. Use a screwdriver to release the lower rail catch of the device and pull the lower part of 
the device away from the rail. 

 
Figure 5-2 SCALANCE S removing from a DIN rail (35 mm) 
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5.2.2 Installation on a standard rail 

Installation on a SIMATIC S7-300 standard rail  
1. Place the upper guide at the top of the SCALANCE S housing in the S7 standard rail. 

2. Screw the SCALANCE S device to the lower part of the standard rail. 

 
Figure 5-3 SCALANCE S installation on a SIMATIC S7-300 standard rail 
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5.2.3 Wall mounting 

Installation fittings 
Use the following fittings, for example when mounting on a concrete wall: 

● 4 wall plugs, 6 mm in diameter and 30 mm long 

● Screws 3.5 mm in diameter and 40 mm long 

 
  Note 

The wall mounting must be capable of supporting at least four times the weight of the 
device. 

 

5.2.4 Grounding 

Installation on a DIN rail  
The device is grounded over the DIN rail. 

S7 standard rail   
The device is grounded over its rear panel and the neck of the screw. 

Wall mounting   
The device is grounded by the securing screw in the unpainted hole. 

 

 Note 

Note that the SCALANCE S must be grounded over a securing screw with low resistance. 
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 Commissioning 6 
 

 
 

 NOTICE 

Before you connect the device! 

Before putting the device into operation, make sure that you read the information in the 
sections "Product properties" and "Installation" carefully and follow the instructions there, 
particularly those in the safety notices.  

 

Principle 
To operate the SCALANCE S, you need to download a configuration created with the 
Security Configuration Tool or STEP 7 as of V12. Configuration using the Security 
Configuration Tool is described below.  

Configuring a SCALANCE S also includes the following aspects: 

● Mode selection 

● IP parameters 

● Firewall rules 

● IPsec tunnel (not for S602) 

Before putting the device into operation, you can first create the entire configuration offline 
and then download it.  

Depending on the application, download the configuration to one or more SCALANCE S 
devices during the commissioning phase. 
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Figure 6-1 Overview of commissioning 

 

Factory defaults  
With the factory defaults (settings as supplied or after resetting to factory defaults), the 
SCALANCE S behaves as follows after you turn on the power supply: 

● IP communication is not possible since the IP settings are missing; the SCALANCE S 
itself does not yet have an IP address. 

As soon as the SCALANCE S device is assigned a valid IP address by the configuration, 
the device is accessible (IP communication is then possible). If router information is also 
included in the configuration and has been downloaded to the SCALANCE S, the device 
can also be reached via routers. 

● The device has a fixed, default MAC address; the MAC address is printed on the device 
and must be used during configuration. 

● The firewall is preconfigured with the following basic firewall rules:  

– All frames from internal to external and vice versa are blocked. 

– All frames from internal to the SCALANCE S device are allowed 

– For SCALANCE S623/S627-2M: In terms of the basic firewall settings, the DMZ 
interface behaves like an external interface. 

The unconfigured status can be recognized when the fault display is lit orange. 
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6.1 Step 1: Connecting up the SCALANCE S device 

Follow the steps below: 
1. First unpack the SCALANCE S and check that it is undamaged. 

2. If applicable, insert the media modules and SFPs in the SCALANCE S (S627-M2 only). 

 

 
 NOTICE 

Install and remove media modules only when the power is off 

Media modules may only be inserted in or removed from a SCALANCE S device when 
the power supply to the device has been turned off. 

Use only approved media modules and SFPs 

Only use media modules and SFPs in the modules slots that are supported by the 
SCALANCE S627-2M. These media modules and SFPs are listed in the following 
section: 
• Technical specifications (Page 11) 

 

3. Connect the power supply to the SCALANCE S. 

Result: After connecting the power, the fault display (F) is lit yellow. 

4. Now establish the physical network connections by plugging the network cable 
connectors into the ports you want to use (RJ-45 jacks or media module ports). 

– Connect the external interface with the external network to which the configuration 
PC/PG is connected. 

– Connect the internal interface with the internal network. 

– If applicable, connect the DMZ interface with the corresponding network component. 

Note: 

During commissioning, you can, in principle, initially connect the configuration PC/PG to 
one of the interfaces of the SCALANCE S device and do without a connection to other 
network nodes until the device has been supplied with a configuration. If you connect 
directly to the SCALANCE S interfaces, however, you would need to configure each 
individual SCALANCE S device separately. 

If you use the DMZ interface for the initial download of a configuration (assignment of 
initial IP addresses to the interfaces), you should enable the DMZ interface in this 
configuration. Initial download of a configuration via the DMZ interface is possible only as 
of SCT V4.0. 

5. Now continue with the next step "Configuring and downloading". 
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6.2 Step 2: Configuring and downloading 
The section below describes how to configure the SCALANCE S module with the Security 
Configuration Tool starting from the factory settings. 

Follow the steps below: 
1. Start the supplied Security Configuration Tool configuration software. 

2. Select the "Project" > "New..." menu command. 

3. In the dialog that follows, create a new user with a user name and the corresponding 
password. The "administrator" role is assigned to the user automatically. Confirm your 
entries with "OK". 

Result: A new project is created. The "Selection of a module or software configuration" 
dialog opens.  

4. Configure the product type, module and firmware release. 

5. In the "Configuration" area, enter the MAC address in the required format. 

The MAC address is printed on the front of the SCALANCE S module. 

 
6. Enter the external IP address and the external subnet mask in the relevant boxes and 

confirm the dialog with "OK". 

Result: The module will then be displayed in the list of configured modules. 
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7. Select your module and, if necessary, enter the IP address of the default router by 
clicking in the "Default Router" column. 

 
Optional: Configure any other properties of the module if required. You will find more 
detailed information on this in the configuration manual "Industrial Ethernet Security - 
Basics and Application" that can also be found on the product data medium. 

8. Save the project with the following menu command: "Project" > "Save As...". 

9. Select the module in the content area and select the menu command "Transfer" > "To 
module...". 

When you first load a configuration after installing the Security Configuration Tool, a 
dialog appears in which you can select the required network adapter. 

10.If you click on the "Start" button in the "Download configuration data to security module" 
dialog, you transfer the configuration to the SCALANCE S module. 

 
Result: The SCALANCE S module is now configured and can communicate at the IP 
level. This mode is indicated by the Fault display being lit green. 
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 Troubleshooting/FAQs 7 
7.1 Replacing a SCALANCE S device 

When using a C-PLUG, a SCALANCE S device can be replaced without a PC (without 
needing to download the configuration to the new device). The C-PLUG of the device you 
are replacing is simply inserted in the new device you want to put into operation, refer to the 
following section of this manual: 

● C-PLUG (configuration plug) (Page 27) 

 

 NOTICE 

Damage to hardware by replacing during operation 

Replacing the C-PLUG during operation can lead to damage to the hardware (device and 
C-PLUG).  

Replace the C-PLUG only when the device is de-energized. 
 

7.2 Transferring new firmware 
You can download new firmware versions to a SCALANCE S device with the Security 
Configuration Tool or STEP 7 as of V12.  

Requirements 
To transfer new firmware to a SCALANCE S device, the following conditions must be met: 

● You must have administrator rights for the project.  

● The SCALANCE S device must already have been configured with an IP address and be 
reachable. 

The transfer is encrypted 
The firmware is transferred over a secure connection and can therefore also be transferred 
from the unprotected network.  

The firmware itself is signed and encrypted. This ensures that only authentic firmware can be 
downloaded to the SCALANCE S device. 
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The transfer can take place during operation 
The firmware can be transferred while a SCALANCE S device is in operation. 
Communication is, however, interrupted after the download until the automatic restart of the 
SCALANCE S device is completed. Newly downloaded firmware only becomes active after 
the SCALANCE S device has been restarted.  

If the transfer is disrupted and aborted, the device starts up again with the old firmware 
version.  

Make the transfer in the Security Configuration Tool as follows: 
Select the SCALANCE S in the content area and select the menu command "Transfer" > 
"Transfer firmware...". 

7.3 SCALANCE S device does not restart correctly 
If the fault LED of the SCALANCE S device is lit red after booting, you should first completely 
reset the device. Press the reset button until the fault LED starts to flash orange-red. The 
device is then reset to the factory settings and runs a reboot. For productive operation, you 
must then download the configuration to the device again. 

If rebooting fails three times in succession, the firmware is reset to the previously used 
version. If, however, the fault LED of the SCALANCE S device continues to be lit red, the 
device will need to be sent in for repair. 

See also 
Reset button - resetting the configuration to the factory settings (Page 25) 

7.4 SCALANCE S device cannot be reached 

Possible causes: 
● Your computer is not in the same network as the SCALANCE S device. 

● The SCALANCE S device is currently running a reset. 

7.5 SCALANCE S device is compromised 
A SCALANCE S device is compromised when  

● the private key belonging to the server certificate, 

● the private key of the certificate authority, 
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● the key of a VPN group with the authentication method "Pre-shared key" or 

● the password of a user has become known. 

Private key of the server certificate known 
If the private key belonging to the server certificate has become known, the server certificate 
on the SCALANCE S device must be replaced. The user names stored on the SCALANCE S 
device do not need to be changed.  

Security Configuration Tool - follow the steps below: 
1. Select the "Options" > "Certificate manager..." menu command, "Device certificates" tab. 

2. Select the SSL certificate of the SCALANCE S module and select the entry "Renew 
certificate..." in the shortcut menu. 

3. Enter the parameters for the new SSL certificate and confirm your entry with "OK". 

4. Download the configuration to the SCALANCE S module. 

The private key of the certificate authority is known 
If the private key of the certificate authority has become known, the certificate of the 
certificate authority must be replaced on the SCALANCE S module. The user names can 
remain unchanged. The VPN groups do, however, require new certificates provided by the 
new certificate authority.  

Security Configuration Tool - follow the steps below: 
1. If necessary, change the project to advanced mode with the menu command "View" > 

"Advanced mode". 

2. In the navigation area, select the VPN group you want to edit. 

3. Select the "Edit" > "Properties..." menu command. 

4. Generate a new VPN group certificate by clicking the "New..." button in the "Certificate" 
area. 

5. Confirm the next two dialogs with "Yes" or "OK". 

6. Download the configuration to all SCALANCE S modules that belong to the VPN group. 

The key of a VPN group with the authentication method "Pre-shared key" is known 
If the key of a VPN group that uses the authentication method "Pre-shared key" has become 
known, the key must be renewed in the VPN group properties of this VPN group. Following 
this, the new configuration must be downloaded to all SCALANCE S modules that are 
members of the VPN group. 
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Security Configuration Tool - follow the steps below: 
1. If necessary, change the project to advanced mode with the menu command "View" > 

"Advanced mode". 

2. In the navigation area, select the VPN group you want to edit. 

3. Select the "Edit" > "Properties..." menu command. 

4. Generate a new key by clicking the "New..." button in the "Pre-shared key" area. 

5. Confirm the next dialog with "Yes". 

6. Download the configuration to all SCALANCE S modules that belong to the VPN group. 

Password of a user is known 
If the password of a user with administrator rights relating to configuration and/or to a module 
or several modules is known, the server certificate of the corresponding module and the 
password of the user should be changed. 

If the password of a user who is assigned the "standard", "diagnostics" or "remote access" 
role is known, the password of the user should be changed. 
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 Dimension drawings 8 
 

 

Dimension drawing for SCALANCE S602 / S612 / S623 devices 
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Dimension drawing for SCALANCE S627-2M devices 
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 Approvals A 
 

 

The SIMATIC NET products described in these Operating Instructions have the approvals 
listed below. 

 

 Note 
Issued approvals on the type plate of the device 

The specified approvals apply only when the corresponding mark is printed on the product. 
You can check which of the following approvals have been granted for your product by the 
markings on the type plate. 

 

Current approvals on the Internet 
You will find the current approvals for the product on the Internet pages of Siemens Industry 
Online Support. 

https://support.industry.siemens.com/cs/ww/de/en/15327/cert 
(https://support.industry.siemens.com/cs/ww/en/ps/15327/cert) 

EC directives 
SIMATIC NET products meet the requirements and aims of the following EC directives. 

EMC directive (electromagnetic compatibility) 
The SIMATIC NET products described in these operating instructions meet the requirements 
of EC directive 2004/108/EC "Electromagnetic Compatibility" for the following areas of 
application: 
 
Field of application Requirements 

RF interference level Immunity to interference Degree of protec-
tion 

Industry EN 61000-6-4 : 2007 EN 61000-6-2 : 2005 IP20 

RoHS directive (Restriction of certain Hazardous Substances) 
The SIMATIC NET products described in these operating instructions meet the requirements 
of the EC directive 2011/65/EC for the restriction of the use of certain hazardous substances 
in electrical and electronic equipment. 

● Applied standard: EN 50581:2012 

https://support.industry.siemens.com/cs/ww/en/ps/15327/cert
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 WARNING 

Personal injury and property damage can occur 

The installation of expansions that are not approved for SIMATIC NET products or their 
target systems may violate the requirements and regulations for safety and electromagnetic 
compatibility. 

Only use expansions that are approved for the system. 
 

● Keep to the installation guidelines 
The devices meet the requirements if you adhere to the installation and safety 
instructions contained in this documentation and in the following documentation when 
installing and operating the devices. 

● You can always find the latest documentation on the Internet 
The current descriptions of the currently available products can always be found on the 
Internet under the specified entry IDs/Internet pages: 

– "Industrial Ethernet / PROFINET Industrial Ethernet" System Manual 

– "Industrial Ethernet / PROFINET - Passive network components" System Manual 

– "EMC Installation Guidelines" configuration manual 

60612658 (http://support.automation.siemens.com/WW/view/en/60612658)  

● Working on the device 
To protect the device from electrostatic discharge, personnel must first discharge any 
electrostatic charge from their body before touching the device. 

 
  Note 

The test was performed with a device and a connected communications partner that also 
meets the requirements of the standards listed above. 

When operating the device with a communications partner that does not comply with 
these standards, adherence to the corresponding values cannot be guaranteed. 

 

EU declaration of conformity 
You will find EC declaration of conformity for these products on the Internet pages of 
Siemens Industry Online Support 
(https://support.industry.siemens.com/cs/ww/en/view/66920341). 

Notes for the Manufacturers of Machines 
This product is not a machine in the sense of the EC Machinery Directive. There is therefore 
no declaration of conformity relating to the EC Machinery Directive for this product. If the 
product is part of the equipment of a machine, it must be included in the procedure for 
obtaining the declaration of conformity by the manufacturer of the machine. 

http://support.automation.siemens.com/WW/view/en/60612658
https://support.industry.siemens.com/cs/ww/en/view/66920341
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cULus Approval for Information Technology Equipment 
cULus Listed I. T. E. 

Underwriters Laboratories Inc. complying with 

● UL 60950-1 (Information Technology Equipment) 

● CSA C22.2 No. 60950-1-03 

Report no. E115352 

● UL 508 

● CSA C22.2 No. 142-M1987 

Report no. E85972 

cULus Approval Hazardous Location 
cULus Listed I. T. E. FOR HAZ. LOC. 

Underwriters Laboratories Inc. complying with 

● UL 60950-1 (Information Technology Equipment) 

● ANSI/ISA 12.12.01-2007 

● CSA C22.2 No. 213-M1987 

Approved for use in 
Cl. 1, Div. 2, GP A, B, C, D T4 
Cl. 1, Zone 2, GP IIC T4 

Report no. E240480 

FM 
The product meets the requirements of the standards: 

● Factory Mutual Approval Standard Class Number 3611 

● FM Hazardous (Classified) Location Electrical Equipment: 
Non Incendive / Class I / Division 2 / Groups A,B,C,D / T4 and 
Non Incendive / Class I / Zone 2 / Group IIC / T4 
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ATEX (explosion protection directive) 
 

 WARNING 

When using SIMATIC NET products in hazardous area zone 2, make absolutely sure that 
the associated conditions in the following document are adhered to: 

"SIMATIC NET Product Information Use of subasseblies/modules in a Zone 2 Hazardous 
Area". 

You will find this document 
• on the data medium that ships with some devices. 
• on the Internet pages of Siemens Industry Online Support 

(https://support.industry.siemens.com/cs/us/en). 

Enter the document identification number C234 as the search term. 
 

SIMATIC NET products meet the requirements of the EC directive:94/9/EC "Equipment and 
Protective Devices for Use in Potentially Explosive Atmospheres". 

ATEX classification: 

II 3 G Ex nA IIC T4 Gc 

KEMA 07ATEX0145 X 

The products meet the requirements of the following standards: 

● EN 60079-15 (electrical apparatus for potentially explosive atmospheres; Type of 
protection "n") 

● EN 60079-0 (Explosive atmospheres - Part 0: Equipment - General requirements) 

The current versions of the standards can be seen in the EU Declaration of Conformity. 

IECEx 
The SIMATIC NET products meet the requirements of explosion protection according to 
IECEx. 

IECEx classification: 

Ex nA IIC T4 Gc 

DEK 14.0025X 

The products meet the requirements of the following standards: 

● IEC 60079-15 (Explosive atmospheres - Part 15: Equipment protection by type of 
protection "n") 

● IEC 60079-0 (Explosive atmospheres - Part 0: Equipment - General requirements) 

The current versions of the standards can be seen in the EU Declaration of Conformity. 

RCM 
The product meets the requirements of the AS/NZS 2064 standard (Class A). 

https://support.industry.siemens.com/cs/us/en
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MTBF (40 °C) 
● SCALANCE S602/S612: 54,56 a 

● SCALANCE S623: 52.42 a 

● SCALANCE S627-2M: 38.13 a 

Marking for the customs union 
EAC (Eurasian Conformity) 

Customs union of Russia, Belarus and Kazakhstan 

Declaration of the conformity according to the technical regulations of the customs union 
(TR CU) 
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A 
AC voltage, 16 
Administrator rights, 43 
Approvals, 5 
Article numbers, 13 
Attachments, 11 
Autocrossover, 24 
Autonegotiation, 24 

B 
Basic rules for firewall, 38 

C 
Cable lengths, 11 
CD, 16 
Commissioning, 37 
Components of the product, 16 
Configuration, 5 

Initial, 37 
Loading, 37 

Configuring offline, 37 
C-PLUG, 27 

Empty, 28 
Removing, 27 
Replacing, 27 
Reset, 29 

C-PLUG slot, 28 

D 
Degree of protection, 15 
DIN rail, 15, 31, 32 
Displays, 20 

Fault display, 20 
Port status LEDs, 20 
Power LEDs (L1, L2), 20 

E 
Electrical data, 11 
Environmental conditions, 12 

Ethernet cable 
Crossover, 24 

F 
Factory defaults, 25, 38 
Firmware update, 43 

G 
Glossary, 6 

H 
Hardware, 5, 15 

I 
Installation, 31, 31 

Installation on a DIN rail, 32 
Installation on a standard rail, 34 
Types of installation, 31 
Uninstalling, 33 
Wall mounting, 35, 35 

Installation location, 12 

L 
Load distribution, 16 

M 
M32 screw cover, 28 
MAC address, 28, 37 
MDI / MDIX autocrossover function, 24 
Media modules, 12 

N 
National Electrical Code,table 11 (b), 16 

P 
Port status LEDs, 20 
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Possible attachments, 23 
Power display, 20 
Power supply, 15, 16 

R 
Replacement device, 28 
Replacing a device, 28 
Reset button, 25 
Reset to factory settings, 26 
RJ-45 jacks, 23 

S 
S7 standard rail, 35 
Safety notices 

general, 7 
Use in hazardous areas, 7 

SFP, 13 
Signaling contact, 17 
SIMATIC NET glossary, 6 
Standard rail, 31, 34 
Standards, approvals, 13 

EN61000-4-5, 31 
IEC950/EN60950/ VDE0805, 16 

Status as supplied, 38 
System manual, 50 

T 
Terminal block, 16 
TP interfaces, 23 
TP ports 

Insulation, 25 

W 
Wall mounting, 31, 35 
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